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Introduction 
 
The Keysight Precision IV Analyzers (E5260A/E5262A/E5263A/E5270B) enable quickly highly accurate 
current-voltage measurements using the powerful characterization software, EasyEXPERTgroup+ 
(“EasyEXPERT”) and integrated source and measurement units (SMUs). 
  
This Quick Start Guide helps you to learn the features of EasyEXPERT and gives you step by step 
instructions on how to perform the basic current-voltage measurements. 
 
 
Chapters 1 and 2 provide instructions for the hardware and software setup including the cable 
connection from the instrument to the device terminal before starting each Lab. 
 
Chapter 3 provides the lab exercises to learn the basic operations, from measurement setup to 
execution and analysis. 
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1. Preparation 
 

1.1 The required instrument configuration, accessories and demo 
device for the lab 

  

1.1.1 Instrument configuration 
The lab exercise in this document requires one of the Precision IV Analyzers (E5260A/E5270B) 
that are configured with four or more SMUs. This document is described using the E5270B with 
the following configuration of four SMUs.  

– SMU1: E5281B Precision MPSMU 
– SMU2: E5281B Precision MPSMU 
– SMU3: E5281B Precision MPSMU 
– SMU4: E5281B Precision MPSMU 

You could use Analyzer E5260A instead of E5270B or another type of SMU besides E5281B 
MPSMU. 
 

1.1.2 Accessories 
– Keysight N1295A Test Fixture x 1 

 
– Power Cable x 1 
– GPIB interface x 1 
– Triaxial Cable x 4  

 

Keysight N1295A Test Fixture 

Power cable 82357B USB/GPIB Interface 
High-Speed USB 2.0 

16494A Triaxial cable 



1.1.3 Demo device 
The following device is used in this document; 
 
Demo Device : MOSFET SD214DE 
 
Basic characteristics: 

• Nch MOS FET 
• Max Vd : 10 V 
• Max Vg : 10 V 
• Max Id : 50 mA 
• Vth : <1.5 V 
• Typical Ig : <1 pA  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  
There is no protection diode connected to the gate, and it can easily be damaged. Leave the 
shorting wire in place to protect the gate from damage. 
When handling the device without the shorting wire, observe the following precautions: 

• Do not touch to the gate pin. 
• Discharge your body's static charge by touching a convenient earthing point.  

 
  

Picture of SD214DE 
Pin configuration of 

SD214DE 

Shorting 
wire 



1.2 Installation of EasyEXPERT software 
 

1.2.1 PC prerequisite  
Set up a computer which satisfies the system requirements of EasyEXPERT. 
For further information, see the README file included in the installation package of 
EasyEXPERT group+ software (for PC) on K.com. 
www.keysight.com/find/easyexpert 

 
 

1.2.2 Installation of EasyEXPERT 
The latest version of EasyEXPERTgroup+ can be downloaded from K.com. 
www.keysight.com/find/easyexpert 
 
Install the EasyEXPERT software in your external PC by following the procedure described 
in the README file. 

 
 

1.2.3 License file installation for EasyEXPERT 
For the purposes of your demo evaluation, EasyEXPERT group+ allows you to execute the 
measurements for two hours, without the need for the purchased license.  When the two hours 
have passed, you can re-start EasyEXPERT. 

 
If, however, you have the purchased license, refer to the detailed installation procedure in the 
EasyEXPERT user's guide. 
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2. Before starting the Lab 
 

2.1 Instrument setup 
This section covers the following topics: 

• Turning on the Instrument 
• Setting up the instrument GPIB address 
• Confirming the GPIB address using Connection Expert 

 

2.1.1 Turning on the instrument 
Connect the power cable from the E5270B to an AC power outlet, and press the “Line” switch. 

 
 

2.1.2 Setting up the instrument GPIB address 
Step 1. Press the Menu key.  

 

 
 
 



CONFIG    MONITEM    DSPLFRMT 

2-1 

2-2 

 

OUT:         0.00 U 

ADDRESS    LINEFREQ    REVISION    UNIT 
OFF       OUT:         0.00 U 

3-1 

3-2 

 

 

ADDRESS    LINEFREQ    REVISION    UNIT 
OFF                               OUT:         0.00 U 

Step 2. Move the cursor to CONFIG, and then press the Enter key. 

 

 
Step 3. Move the cursor to ADDRESS, and press the Enter key. 

 

 



Step 4. Press the arrow keys to set the GPIB address. 
• Left and right arrow keys change the position 
• Down and up arrow keys change the GPIB address number. 
 

 
 

Step 5. Press the Enter key to make the setup effective, or press the Exit key to cancel any 
changes to the setup. 

 
 

 

GPIB    ADDRESS    =    16  GPIB    ADDRESS    =    16 

OFF                                    OUT:         0.00 U 



GPIB 
Connector 

PC 

E5270B rear panel 

82357B GPIB cable 
 

Step 6. Press the Exit key twice to close the setup menu. 

 
2.1.3 Confirming the GPIB address using Connection Expert 
 

Step 1.  Connect the E5270B to your PC using the GPIB interface cable. 

 

 
Step 2. Check the E5270B GPIB Address using Connection Expert 

• Open the “Keysight Connection Expert” from the Windows start menu 
• Select the Instruments tab 
• Check the VISA insterface ID and the GPIB address as follows. 

In the following example, you can see VISA interface ID is “0” and GPIB Address is “16”. 
 

Note: If the instrument is not displayed in Connection Expert, click Rescan. For more detailed 
information, refer to Help of Connection Expert.  

 
 
 
 



1. 

2. 

3. 

 
 
 

 
 

2.2 EasyEXPERT setup 
Prepare EasyEXPERT as follows: 
• Start EasyEXPERT 
• Make a new workspace for the demo 
• Set the power line cycle 

 

2.2.1 Starting EasyEXPERT 
 

Step 1.  Start EasyEXPERT by clicking the following short cut icon on the Windows desktop 
or by clicking on Start EasyEXPERT in the Start menu. 

 
 
 
 
 



Step 2. Set the online mode and GPIB address of the instrument. 
a. Click "Options". 
b. Click "Execution Mode...", the Execution Mode window will open. 

 
c. Check "Online" and set “VISA interface ID” and ”GPIB address” 

 
Note: If you don’t know what GPIB Address to set here, please refer to “1-4. 
Preparation of instrument” 

 
d. Click "OK", and close the Execution Mode window 

 
Step 3. Click "Start EasyEXPERT", EasyEXPERT will start. 

 

 

 

 



 
2.2.2 Making a new workspace for the demo 

 
EasyEXPERT group+ has a built-in database called “workspace”. Every time the measurement 
is performed, the combination of measurement setup and result can be stored automatically 
into the workspace, allowing you to store and rapidly recall the data that you need. You can 
create your private workspaces or public workspaces for shared usage. 
 

Step 1. Opening the workspace configurator window 
 
When you click Start EasyEXPERT, a window will open, but the contents of the window 
depends on the number of existing workspaces, Case 1: No existing workspaces (first time use), 
Case 2: One workspace and Case 3: Two or more workspaces.  Create your own case using the 
Workspace Configuration window, then go to Step 2. 
 
Case 1: No existing workspaces (first time use) 
Close workspace by selecting "Close Workspace” from the “File” menu, and go to the 
EasyEXPERT workspace management window (Case2). 
 

 
Case 2: One existing workspace 
Click the "No, I want to manage Workspaces" radio button. 

 

After clicking "Close 
Workspace", The 
Case 2 window will 
open. Go to Case 2.. 

 

After clicking OK, The 
Workspace Configurator 
window will open. Go to Step 
2. 
 



 
 

Case 3: Two or more existing workspaces 
The Workspace Configuration window will open, then go to Step 2. 

 

 
Step 2. Making a new Workspace for the demo. 

Click on the "Create a new Workspace” radio button. Enter, for example, “Demo Workspace” as 
a unique name in the new workspace entry field. Click “Continue” and go to “Preparing the 
Measurement environment”.  

 

Go to Step 2. 
 

1. 
2. 

3. 



 

 
2.2.3 Setting the power line frequency 

Setting the power line frequency is very important for accurate and stable measurements in 
low signal voltage or current. Check the line frequency setting of your instrument, and set the 
line frequency of your area. 
 
Open the Configuration Window by selecting "System -> Configuration” from the “Tools” menu, 
and go to the Tab of “Main Frame” and check the Line frequency. 

 

 
 

  

2. 3. 
1. 



2.3 Making connections between the instrument and the demo 
device 

The connection between the instrument and the demo device is made by undertaking the 
following: 

• Checking the configuration on EasyEXPERT. 
• Connecting the cables between the instrument and the demo device 

 

2.3.1 Checking the configuration on EasyEXPERT 
Open the Configuration by selecting Tools > System > Configuration… and check each Slot (*1) 
number against its corresponding module Name used in EasyEXPERT (*2). 

 
 
 The Ground Unit is referred to as "GNDU" in EasyEXPERT.  The GNDU is located within the 

mainframe of the Precision IV analyzer and its terminal is located on the front panel of the 
instrument. 

 
 
 
 
 

(*1) (*2) 



 
 
 The SMU is named according to the SMU number +”:”  +  Module Type. ( i.e. HR for HRSMU ) on 

EasyEXPERT. The SMU number is dictated by the following rules. Note that the SMU number is not 
the same as the slot number. 

• Count the SMU numbers in ascending order of the slot numbers as illustrated in the 
diagram below. 

 

 
 
• HPSMU occupies the 2 slots of the mainframe, but the increment of the SMU number is 1. 
• Do not count the empty slots. 

 
Below illustrates an example of two HPSMUs installed in slots 2 and 4, and two MPSMUs 
installed in the slots 5 and 7. 
 

 
 

Note: For the remainder of this document, the SMU number will be used to specify a SMU on 
the instrument. 

  

SMU2 

 SMU3 

SMU4 

SMU1 



2.3.2 Cabling between the instrument and the demo device 
 

The following diagram illustrates the connection overview. Connect the cables between the instrument 
and the test fixture, then set the demo device on the test fixture.  

 
Step 1. Connect the instrument to the Fixture (N1295A) 
A SMU has both Force and Sense terminals. In the labs in this guide, only the Force terminal is 
used, the Sense terminal should be kept Open. 
 

1-1. Connect the Force terminal of SMU1 to Port1 of the N1295A Test Fixture using a 
triaxial cable. 

1-2. Connect the Force terminal of SMU2 to Port2 of the N1295A Test Fixture using a 
triaxial cable. 

1-3. Connect the Force terminal of SMU3 to Port3 of the N1295A Test Fixture using a 
triaxial cable. 

1-4. Connect the Force terminal of SMU4 to Port3 of the N1295A Test Fixture using a 
triaxial cable. 

 

Top view of 
N1295A Test Fixture 

E5270B Front panel 

Top view of 
SD214DE Demo device 

SMU1 

SMU2 

SMU3 

SMU4  1-3 

 1-4 

 1-2 

 1-1 
 

 
 
 
 
 
 
 
 
 
 

Force Sense ( Keep Open in the labs )  

Front View of a SMU 



Note: A Sense line is used for high current measurement or low resistance measurement to 
minimize the measurement error caused by the residual resistance of the connection cables. 

  
Step 2. Set the SD214 Demo Device to the N1295A Test Fixture 
 

Step 2-1. Before connecting, position the Demo Device leads so that they fit to the 
N1295A device socket. 
 

 
Step 2-2. Insert the device (SD214DE) into the socket on the Test Fixture 

 
 Step 2-3. Remove the shorting wire 
 
 
You have now completed the connections, as detailed below, between the instrument and the demo 
device. 

 
 

N1295A 
Port number 

Pin Name 

1 Source 

2 Drain 

3 Gate 

4 Sub 

Unit 
N1295A 

Port number 
Pin Name 

SMU1 1 Source 

SMU2 2 Drain 

SMU3 3 Gate 

SMU4 4 Sub 

Note: While positioning the leads, leave the shorting wire in place to protect the gate from any damage. 
 

Connection table 

S 

D G 

Sub 
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Application Test Mode supports measurements in three easy steps by 
utilizing extensive libraries of hundreds of pre-defined tests.

Step 1: Select a measurement from one of the furnished libraries.

Step 2. Modify the measurement parameters as needed.

Step 3. Click the measure button to start the measurement.

=> Measurements are performed and parameters are automatically extracted.

– You can store your chosen test setup (Step 2) into a "My Favorite Setup" list for 
quick future execution.

– Application tests can easily be modified and customized using EasyEXPERT’s built-
in graphical programming environment.

– For customized tests,  Classic Test mode which allows full hardware control is also 
available as detailed in Lab2 – Classic Test Mode.
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Let’s start the Lab. Using application test mode, measurements can be 
executed in three simple steps.

– Step1:Select a measurement from one of the furnished libraries.
1-1. Click “Application Test” Tab

1-2. Put a check mark to CMOS in the Category menu. 

1-3. Input “Id-Vd” into the Incremental search box.  

1-4.Select Id-Vd, then click "Select".

– Step2:Modify the measurement parameters as needed.
Enter the following parameters,

– Step3:Click the measure button to start the measurement.

3-1-3

Primary Sweep

Gate SMU3:MP

VgStart 2.00V

VgStop 4.00V

VgStep 500mV

Secondary Sweep

Drain SMU3:MP

VdStart 0V

VdStop 5.00V

VdStep 50mV

Subs SMU4:MP

Vsubs 0V

Source SMU1:MP

Polarity Nch Lg 100nm Wg 10.0um

Temp 25.0 deg IdMax 50mA



– After you click the single measure button,
1.The Test Result window showing the measurement data of the Id-Vd Demo 
application test will open.

2.The Test Result Editor box will pop up after each measurement.

– To save your data:
• Unless you click the "Delete" button on the "Test Result Editor", by default, 

all of your measurement data will be saved to the "Test Record List" area.

• You can add “Flags” (to indicate the status of your test result) and “Remarks” 
to your test result, and you can use these parameters for filtering your test 
results when you produce a report.

You can ignore this window if there is no comment on the measurement 
result. Your data is saved automatically.

• If you do not wish to save this test result, click "Delete".  The data will still 
automatically be saved and flagged as deleted data.

– Analyzing your data:
• You can analyze your measurement data - please see Lab 3: "Graph Analysis 

Function" for details. 
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– Saving the setup with modified parameters:
• You can save the setup with modified parameters into "My Favorite Setups 

(preset group)“. You can create your own groups and save your setups within 
them. It allows you to quickly start the measurement without the need for 
parameter modification. The test setup can be exported and imported by the 
group level.

– To create a new group:
1-1. Click "My Favorite Setups". -> "My favorite Setup" menu opens.

1-2. Click "New … " -> "Group Name" the input window will pop up.

1-3. Enter the Group name, for example "Demo-1“ and click "OK" .

1-4. A new preset group is created.

– To save and recall an application test setup:
2-1. Enter a new setup name to "Setup name" field, for example, Id-Vd Demo1

2-2. Click "save"  - the test setup is saved to "My Favorite Setup group“

2-3. To recall a test setup, select it from within your chosen setup group and click 
the "Recall" button.
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– What is Classic Test mode?
• Classic Test mode can be used as a standalone test engine and it can define a unique 

test.

• Any application or functionality not furnished in the Application Test library can be 
performed using Classic Test mode.

• The user interface of the Classic Test mode can be easily learned and adopts the same 
concepts as the Keysight 4155/56 parameter analyzer that has been the 'go to' standard 
analyzer for some time.

• Classic Test mode represents the fundamental method of instrument control, and all of 
the pre-defined application tests included in the Application Test mode libraries 
internally use the Classic Test mode.

– Classic Test mode
The following modes are available.

• I/V Sweep: For X-Y measurements of I or V.

• Multi Channel I/V Sweep: For simultaneous multi channel sweep measurements of I or V.

• I/V List Sweep: For multi channel I/V sweep measurements using list data.

• Switching Matrix Control: For B2200/E5250 switching matrix control.
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Let's start the Lab. In this Lab, you will be taking the same measurement as 
the Vth gmMax Application Test undertaken in Lab 1, but this time in 
Classic Test Mode.
Note: In this Lab, you will learn the various parameters of Classic Test mode. See the 
EasyEXPERT User’s guide for further details.

– To Select Classic Test Mode 
I/V Sweep Classic Test mode is used in the demonstration.

Alternatively, you can use "Multi Channel l/V Sweep" Classic Test mode.  There is no 
difference between the two tests but there is a minor difference in the user interface when 
setting up the measurement parameters.

– Follow the next steps to open the I/V Sweep Classic Test mode:
1. Click “Classic Test” tab

The Classic Test execution mode icon appears.

2. Click I/V Sweep mode icon.

“Select” button appears.

3. Click “Select” button.

The I/V Sweep classic test setup editor with Channel Definition page opens.
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– Define Source/Measure Channels
1. Click the Channel Setup tab to display the channel definition screen.

2. Enter the Setup Name for the test setup to be defined on the setup editor. 
Enter "Id-Vg Vth CT". Note: The suffix CT denotes "Classic Test mode".

3. List the SMUs used for source output:  Note: You can delete unused SMUs from the list.

4. Enter the following parameters for the selected SMUs.

5. (Optional): Time Stamp setup

You can record the measurement timing of each sweep step (VAR1).

If you choose this option, enter a variable name in this field, for example "Time".

3-2-4

Unit: V Name: I Name: Mode: Function:

SMU1 Vs Is V CONST

SMU2 Vd Id V CONST

SMU3 Vg Ig V VAR1

SMU4 Vsub Isub V CONST



– Measurement Setup 
Click the Measurement Setup tab to display the measurement parameter definition screen.

The Measurement Setup tab screen is used to set the source output value parameters.

– Setting the Measurement Setup page:
1. Setting the Primary Sweep Source: VAR1 parameters. Enter the following parameters:

2. Setting the Constants: CONST parameters. Enter the following parameters:

3-2-5

Unit: Name Direction
Linear/L

og
Start Stop Step

No. of 
Step

Compliance PwrComp

SMU3 Vg Single Linear -500mV 3V 35mV 101 100uA OFF

Unit: V Name I Name Mode Source Compliance

SMU1 Vs Is V 0V 100mA

SMU2 Vd Id V 100mV 100mA

SMU4 Vsub Isub V 0V 1mA



– Setting the Ranging Mode
The dialog box is used to set the measurement ranging mode.

The available minimum range depends on SMU type.

– To Set the Measurement Range:
1. Click the Range button.

2. The SMU Range Setup dialog box opens. Set the following parameters by necessity.

• Unit: SMU name or number

• Name: Variable name for the measurement data

• Mode: Ranging mode, AUTO, LIMITED, or FIXED

• Note: For the limited auto ranging, the instrument does not use a range lower than the 
specified range value.

• Range: Range value

• Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD

• Rate: Value used for range changing.

• Specify the Rate value, 11 to 100, which fixes the boundary of the ranging.

3. Click “Close”.
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– Setting the ADC/Integration Time
The dialog box is used to select the ADC for each SMU and to set the integration time for 
each ADC (high resolution or high speed).

– To set the ADC/Integration Time:
1. Click the “ADC/Integ” button. The A/D Converter & Integration Time Setup dialog box 

opens.

2. A/D Converter Setup:

• Unit: SMU name or number

• Name: Variable name of the measurement data

• ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)

• Measurement: Compliance side measurement or Force and Compliance sides 
measurement.

3. Integration Time Setup:

• Mode: ADC operation mode

• Factor: Coefficient for the reference value of the integration time.

• Auto Zero: Auto Zero function ON or OFF. For HR ADC.

– HR ADC Set Example:

3-2-7

Integ Time Mode Factor
Short AUTO 8
Medium PLC 1
Long PLC 16



– Vth definition of “Vth gmMax“
The definition of the threshold voltage Vth used in the "Vth gmMax" application test 
is

Vth=Von-(Vd/2)

where,

• Von is the Vgs intercept of the tangent line drawn on the Id-Vg curve at 
the maximum gradient point.

• Vd is the drain voltage applied to the drain for measuring Id-Vg 
characteristics.

– To find the maximum gradient point of Id-Vg characteristics:
1. Measure the Id-Vg characteristics.

2. Create the Gm curve by differentiating the Id-Vg curve.

3. Find the maximum point of Gm curve, the X-coordinate.

4. Put a marker on the X-coordinate found in step 3 on the Id-Vd curve. This is the 
maximum gradient point of the Id-Vg curve.

5. Draw a tangent line on the marker of the Id-Vg curve.

6. The intercept of this line on the Vgs X-axis is the Von, and the Vth is calculated 
by Vth=Von-Vd/2.
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– Setting the User & Analysis Function
Click the Function Setup tab to display the User Function/Analysis Function setup screen. 

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters 
area of the Data Display window.

The analysis functions can be displayed on the Parameters area of the Data Display window.

We set up the same Vth analysis function used in the Lab 2 "Vth gmMax" application test 
definition.

– To Set User Function:
1. Click the “Function” Setup tab.

2. Click "Add" to display the User Function setup line.

3. The User Function Setup line will appear.

Set the following parameters:

Tips: To enter the Definition. 

4. In the Definition field, open the keypad.

5. Click the down arrow of the Variable field and Function Field to set the parameters. You can 
select from the available “Variable” list and available “Function” list. This will eliminate typos 
and result in faster test setup.

6. Click “Enter” to save the definition.
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Name: gm Unit: S Definition: diff(Id,Vg)



– To Set the Analysis Function:
1. Click "Add" to display the Analysis Function setup line.

2. The User Function Setup line appears.

Set the following parameters:

• Name: Function name

• Unit: Unit of the function

• Definition: Definition of the function. The following identifiers can be used.

-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component

-Built-in functions and global variables

-Read out functions

For details, see online help or User’s Guide.
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Name Unit Definition Note

gmMax S max(gm) Search the maximum value of gm

Von V @L1X Find the intercept of X axis of LIne1

Vth V Von-Vd/2 Calculation



– Auto Analysis Line Function Setup
Click the Auto Analysis Setup tab to display the auto analysis setup screen.

The auto analysis capability allows you to display/move the marker/line on the data graph 
automatically after the measurement has been taken.

The above example draws a tangent line at the gmMax data point for Y1 data (=Id).

– To Draw a tangent Line on a Specific Y1-axis Data Point:
Create an automatic line analysis by following the next steps.

1. Click the “Auto Analysis” Setup tab.

2. Put a check mark in the "Interpolation mode" box: You can position the marker between 
measurement points.

3. Put a check mark in the "Enable“ box to enable Line 1. 

4. Select Line Type: “Tangent” line.

5. Put a check mark in the "Fix" box of Line 1. This will fix the line on the Y1 axis.

6. Select the effective axis to draw the line: Y1 line

7. Put a check mark in the "Data Condition" box to set a condition to draw a line. The line is 
drawn on a data point.

8. Enter a variable name and a condition expression to specify where you want the marker 
to be displayed and draw a tangent line on the marker. 

Enter the following condition to set the data condition:

Condition: gm = gmMax
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– Defining the Data Display Parameters
1. Click the “Display” Setup tab to display the data display setup screen.

• The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area in the 
Data Display window.

• The List Display area selects the variables to be listed in the List Display area of the Data 
Display window.

• The Parameters area selects the variables to be listed in the Parameters area of the 
Data Display window.

– To set the X-Y Graph:
Follow the next steps to define the X-Y Graph.

2. Put a check mark in the box of X: axis input line. The X-axis input field becomes active.

3. Click the "Add" button to add an additional line. Y1, Y2 and Y3 scale input field will open.

4. Enter the following parameters:
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Axis Name Sharing Scale Min Max

X Vg (None) Linear -500mV 3V

Y1 Id (None) Linear 0V 2mA

Y2 Gm (None) Linear 0S 2mS

Y3 Id (None) Linear 100fA 10mA



– Setting the List Display:
Follow the next steps to define the list display.

1. Click the "Add" button to add a list display line.

2. The list display line will appear.  

Enter the following parameters:

• Vg, Vs, Vd, Vsub

– Setting the Parameters area:
Follow the next steps to define the Parameters area.

3. Click the "Add" button to add a list parameter line.

4. The list parameter line will appear.

Enter the following parameters:

• Vth, gmMax
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– Executing a measurement
1. Click the “Measure” button to start the measurement.

The Test Result window showing the measurement data of the ld-Vg Vth Classic 
Test will open and the Test Result Editor will pop up after each measurement. 

– Test Result Editor
2. In the "Remarks" field of the Test Results Editor enter, for example "First Vth

measurement".

3. Click "OK". The data will be re-saved.
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The Auto-analysis and graphical display features of EasyEXPERT help to accelerate your analysis, 
providing many powerful analysis tools such as auto-scaling, marker and line operation, multiple Y 
axes capabilities etc.  For example, the data display and intuitive GUI operation allows for the quick 
extraction of the threshold voltage by finding the max position on the gm curve in Y2, drawing the 
tangent line on the ld curve in Y1 and reading out the intercept to the X axis, as illustrated below. 

In this Lab, you will learn about the following analysis functions using the Vth gmMax Application 
Test.

1. Auto scaling the Y Axis

2. Using the Zoom function

3. Marker control

4. Adding text to the graph

5. Saving the analysis results
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– Lets start the Labs.

– Step1:Select a measurement from one of the furnished libraries.
1-1. Click "Application Test" mode.

1-2. Put a check mark in the "CMOS" category.

1-3. Find and click the "Vth gmMax" application test icon.

1-4. enter "gm" in the search field.

– Step2:Modify the measurement parameters as needed.
Enter the following parameters,
Device Parameters

Test Parameters

– Step3:Click the measure button to start the measurement.
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IdMax 2mA

IntegTime MEDIUM

Source SMU1 Drain SMU2 Gate SMU3 Subs SMU4

Vd 100mV VgStart -500mV Vsubs 0V

VgStop 3.00V

VgStep 50mV



– After clicking the single measure button, the Test Result window 
showing the measurement data of the Vth gmMax Demo application 
test will open and the Test Result Editor will pop up after each 
measurement. 

– Test Result Editor
1. Enter, for example, "First Vth measurement" in the Remarks field of the Test Result 

Editor.

2. Click "OK".

The data will be re-saved.
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– What is a “Vth gmMax” application test?
The above slide illustrates the GUI of the “Vth gmMax” application test (left) and the data 
display graph that appears on the measurement or when the data is rerecalled (right).

The output of the “Vth gmMax” application test shows the following output in three 
categories in Data Display window.

– 1. Graph area
The graph area displays the measurement and analysis graphs with marker, cursor and lines.

1-1. Id-Vg curve (in linear scale).

1-2. Gm curve.

1-3. Log scale Id-Vg curve: This is useful for checking the low current characteristics of the 
MOSFET.

– 2. Parameters area
2-1. This shows the extracted parameters - Vth and gmMax - on the graph analysis.

– 3. List Display area
• The following parameters are listed in number format: 

Vgate, Vsource, Vdrain, Vsubs, Idrain, gm
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– Y Axis Scaling

The orange Y2 gm data cannot read the value from the graph because the Y2 scale is too large.

Change the Y axis scale as follows:

1. Click the        icon and change to the           .

2. Click the Auto-scale icon.

3. The graph scale is automatically changed to fit the trace in the graph.
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– The Zoom function
Using mouse click and drag operations, you can zoom in on the graph to check the details of 
the test results and the analysis data within a specified area.

– How to zoom in and cancel the zoom.
1. Choose the area you want to zoom in on  using mouse click and drag.

2. This is the zoomed view

3. Click the "Undo Scaling” button to cancel the zoom.
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You can control Marker functionality in several ways.

A. Controlling the Marker
EasyEXPERT has the following Marker function.

1. Marker ON/OFF icon enables or disables the marker.

2. Interpolation ON/OFF icon enables or disables the interpolation function of measurement data. 
You can read the interpolation data between two actual measurement points.

3. Marker Skip icon moves the marker to the next measurement curve that is added by the VAR2 
variable.

4. Marker Maximum icon moves the marker to the maximum measurement point.

5. Marker Minimum icon moves the marker to the minimum measurement point.

6. Marker Search icon opens the Direct Marker/Cursor dialog box used to specify the coordinate 
values to move the marker.

B. Reading the Marker value
The marker position data is shown in the Marker readout field(B-1).

The display order of the parameters is, from the left;

X axis value, Y1 axis value and Yx (Y2, Y3, Y4 ...) axis value.

C. Moving the Marker
You can move the marker by rotating the mouse wheel.
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– Adding Text to the Graph Display
Adding text to the graph display area can be beneficial for future reporting and analysis.. 

– To add text:
1. Click on “Text” .

2. Click  “New”. 

3. The Text Editorbox appears.  Enter your text, for example, "My Vth gmMax analysis". 

4. The following functions are available for the selected text(s) via the Text menu 

From the left,

• Edit Mode: Edits the selected text.

• Size: Sets the font size of the selected text(s).

• Font: Sets the font of the selected text(s).

• Text Color: Sets the text color of the selected text(s).

• Background Color: Sets the background color of the selected text(s).

• Hide Frame/Show Frame: Hides or shows the frame for the selected text(s).

• Delete: Deletes the selected text(s).

• Note: Click and drag text to move it.
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– Saving the analysis results
After analyzing the results, they can be saved in a re-usable form, allowing you to review and update 
the test results as necessary.  

Note: Any modification information will be destroyed if you do not save it.  

– Saving the analysis results - retaining all graph modifications
1. Click on the "File" menu..

2. Select "Update" from the menu. This will update all the modification you made on the data.

– Only saving the graph image
3. Click "Save Image" to save the image as a bmp, emf, gif, or png file.

Note: By only saving the graph image, any modifications that you have made will not be saved and 
the information will be destroyed.

3-3-10



3-3-11





Contents

1. Overview of this Lab

2. Recalling measurement setup and measured data

3. Editing and saving a graph

1. Adding measurement information to the graph

2. Copying the image

3. Saving the image as your preferred file type

4. Exporting the data

1. Direct Excel Export 

2. Copy List

3. Exporting the data in various format

5. Summary

3-4-1



In this Lab you will learn how to:

1. Recall measurement setup and measured data.  

2. Edit and save a graph report

3. Export the data
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– Recalling the measurement setup and measured data
Every time a measurement is performed, the combination of measurement setup and result can be 
stored automatically into the built-in database known as a “workspace”. The data stored in the 
“workspace” can be recalled for analysis, measurement reproduction and producing a report.

To recall the measurement setup and measured data, 

1. Select the result data line of the "Test Record List" area

In this Lab, select the “Vth gmMax Demo1(remarks: First Vth measurement)” which we 
made in Lab1.

2. Click the "Results" button or right click on the data line.

3. The "Results" menu will open.

4. Select “Recall”.

The measurement setup (5) in the above figure, and the data display window (6) will pop up. Recalling 
data is useful when you need to check the measurement setup, or want to take another measurement 
after reviewing your data.
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– Adding measurement information
You can add the measurement information to a graph using the Graph Preference function of  
EasyEXPERT.

For example, follow these steps to add a Setup Summary and Parameters to the graph.

1. Click the “Preference” button.

2. Select “Edit…”

3. The Graph Preference window appears. Select the “Option” Tab.

4. Put a Check mark to the "Setup Summary" and "Parameters" boxes.

5. This is the Setup Summary.

6. These are the Parameters.
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There are two ways to save the graph file by either copying it or by saving 
the image.

– Copying the graph
The graph displayed on the data display window can be copied to the clipboard.

You can paste the graphic image to other Windows applications.

In the above example, the graph image is pasted to the WordPad.

To copy the graph:

1. Click “Edit” on the Data Display window.

2. Select “Copy image”.

3. Open another application and paste the copied image of the graph.
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– Saving the image
The graph displayed on the data display window can be saved as any of the following:

You can choose following file type

1.Bitmap Image, 2.Enhanced Metafile, 3.GIF Image, and 4.PNG Image.

To save the image:

1. Click “File” on the Data Display window.

2. Select “Save image...”

3. Specify the file name and the directory in which you want to save the data. Select the data 
formats and save. 
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– Exporting the data
You may be needed to extract the list data to analyze the test results in Excel or in another file format. 
This Lab. describes the three ways to extract list data. Direct Excel Export, Copy List, and Export Test 
Record.

– Direct Excel Export
The data display allows you to export data directly to an Excel spreadsheet without having to save the 
data as a CSV file, allowing for more efficient post analysis on any computer.

1. Click “File” on the Data Display window

2. Select "Export to Excel".  The graph image, list data and parameter data will export to Excel and 
the Excel spreadsheet will open automatically.
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– Copying the data list
The data list shown on the data display window can be copied to the clipboard, allowing you to paste 
the data to other Windows applications.

To copy list, follow the next steps.

1. Click “Edit” on the Data Display window.

2. Select “Copy List”.

3. Open your chosen application and paste the list. 
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- Exporting the Test Record:
The measurement data can be exported in various formats.

To export the test result record, follow the next steps.

1. Highlight the result data line of the "Test Record List" area.

2. Click the "Results" button or right click on the data line.

3. The "Results" menu will open.

4. Select “Export”.

5. Select the format in which you want to export the Test record. 

6. Specify the file name and directory in which you want to save the data.
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1. Removing the Demo Device
1. Touch your hand to the Earth ground or circuit common of the test fixture to remove 

static charge - See above picture for details.

2. Remove (pull out) the MOSFET from the test fixture by keeping one of your hands 
touching to the Earth ground - See above picture for details.  

3. Place the MOSFET back in the User Demonstration Device Kit.

2. How to exit EasyEXPERT
1. Click “File”.

2. Select “Exit”.

3. The "Close EasyEXPERT" window pops up, click "OK".
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3. Power off the instrument by pressing the “Line“ button.
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